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1. Android Data Recovery program (ADR512)

Is used for search and display of all possible SQL.ite records [1] from an image of the
device working under control of Android OS and also from files of databases of
SQL.ite (with the damaged structure or unavailable records). It is used in the sphere of
data recovery and a criminalistics research.

The software can work with:

« the file with memory image (received by means of root rights, a unsoldering and
chip reading etc.) or the file of SQL.ite [1] database (obligatory);

» the folder with files (data from an image) that is necessary for tables identification
without databases of the most popular applications (optionally).

The result of program operation consists from:

» tables with records which are displayed in a primary window of the program where
filters (text, phone numbers and dates) and search of Cyrillic alphabet are available;
« the file of a special format with extension.512 which can be opened by this
program;

« archive of results in the form of text files;

* HTML files.

Treat files/tables of result:

* the renamed tables;

o the NTable#### format - the table with ambiguous correspondence;
« the Table#### format - the table without correspondence.

Records with marks:
* Y/red - remote record:;
 N/green - not remote record.

Uniqueness

*The program looks for all SQL.ite-records without binding to certain databases;

|t doesn't use other libraries and access functions to SQLite-records, and uses
implementation of own algorithm (technique) of recognition of SQL.ite-records;

* It uses sorting remote /not remote record for popular applications;

oIt doesn't depend upon new versions of applications (change of a database structure);
*The program integrates records in the table, even if when application is unknown
(deleted or new);

eIt is implemented a search and a records filters system (with supported Unicode)
*Recognition of date and time from numerical format.

Latest version: 2.4.2.0 (December, 14, 2017)



2. System requirements:

» Windows XP, Windows Vista, Windows 7, Windows 10

« Hard drive: no less than 2 GB of the free space on a system disk
* RAM: no less than 1 GB



3. Complete and TRIAL versions, restrictions.

Complete Android Data Recovery version (ADR512wl.exe file). This program
works and gives full functional only if file regkey.dat is available with the conditions
corresponding to the bought license.

TRIAL version of Android Data Recovery (ADR512Trialwl.exe file). It operates
and provides full functional with one restriction: to the end-user is available only a
part of results: the part of text is closed from the user by asterisks (*).



4. Purchase and program installation.
TRIAL version requires to download the latest version of Android Data Recovery
from the website http://512byte.ua/ and to run ADR512Trialwl.exe.

The complete version requires the next steps:
1. Pay the license on the website http://512byte.ua/.

2. Wait for receiving files (links to files) GetHardwarelDwl.exe and ADR512wl.exe
on email mentioned in the previous point.

3.1. Run the program GetHardwarelDwl.exe on the PC where it is planned to use
ADR512wl.exe.

3.2. To send on email: recovery@512byte.com.ua the text file HardwarelD.txt with
information about the equipment.

Example of the HardwarelD.txt file content:

Your Hardware ID:

1055-4E4B-5E3C-9DA0-6F37-EBCA-281B-3CF8.

4, Wait till the file with the license regkey.dat will be received on the mentioned
email.

5. Place the received regkey.dat file in the folder with the ADR512wl.exe file.

6. Run ADR512wl.exe.



5. Order of the program use. Interface.

1. A. It is necessary for recovery of SQL.ite-records from the image file (or file of the
SQL.ite database with the damaged structure or unavailable records):

1) To select the menu item - File&gt;'New Task.

S
Input Data

Source: Image File
0% _Project SALkeWDSpazet 3iaomi Redmi 44 Full Image - Data Decrypted.raw

Good Files Folder
0% Project SALkeW08pazes] 3datal,

Default Settings

Destenation Directory [Empty Folder recommended):
% Project SALikeNDSpaset 3

Check if recard is deleted for all files.
| Show unhamed files.

Show records with one column,

Save rest data to the file rest.bin'.

Calculate md5 for image file.

| Rename tables with unigue link

Fun Cancel

Picture 1

2) To set in a form 'New Task' (picture. 1)
* input data:

o - Source: file image or file of databases SQL.ite (obligatory)

o - Folder with work files of SQL.ite databases (can be empty)

* Default options:

> The Folder for saving the results;

o Flags:

= To define remote records for each file (requires essential time for fulfillment)

= To show not bound files (we recommend to set especially in case of absence of
revised files of databases of SQL.ite)



= To show records with one field (we don't recommend to set for essential shortening
of unnecessary records)

= To save remains in the rest.bin file (remain includes sectors which weren't
recognized as sheet pages of SQL.ite database [1])

=To identify image file md5 (requires considerable time for fulfillment).

= To rename tables with a simple compliance (we recommend to install for more
graphic result).

3) Click the Run button.
4) Wait for the message on process completion of recovery (picture 2).



5) During the program runtime with the physical drive that have different pages’ size
[1], in the course of recovery there will be a dialog window Select Page Size where
the user will need to set preferable page size (picture 3):

Picture 2

Select Page Size

Picture 3

It is required to set the page size 4096 bytes.



1. B. It is required for records recovery from the one file of SQL.ite database with

correct title [1]:

1) To select menu item “File”-> Process the databases file and choose
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Source: Image File
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[:%_Project SOLitetOdpazeh Shakypehs

Check if record is deleted for all files.
| Show unnamed filez.

Show recards with one columin,

Save rest data to the file rest.bin',
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Picture 5

e Source: Image File SQL.ite (picture 4) (obligatory)
2) Set in the form “New task” (picture 5)

e Default options
e The folder for results keeping
e Flags:

= To mark remote records for each file (requires essential time for fulfilment)

= To mark unbound files (we recommend to set especially in case of absence of
recovered files of SQL.ite databases)

=To mark records with one field (we don't recommend to set for essential reduction of
unnecessary records)

*To save residual in the rest.bin file (residual includes sectors which weren't
recognized as sheet pages of the SQL.ite [1] database)

=To compute md5 of the input file.

=To rename tables with the same meaning (we recommend to set for more graphical
result).



3)Click the Run button.

4)Wait for the message about completion of recovery process (picture 6).
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3. Menu item 'File' ->Open file with results' is used for displaying the program results
that have been received earlier from the results file with extension.512

4. Menu item 'File' ->Export results to HTML' generates program results in HTML
format and runs the browser (picture 7).

[ Android Data Recovery - % e - X

C | @ file:///Dy/_Project%2050Lite/O8pazui/13/HTMLI20Export%:20512%20BYTES20[2017-11-14%2015-47-50)/indexhtml ¥r H
Android Data Recovery - 512 BYTE v2.3.9.9
Results

Image: Xiaomi Redmi 4A Full Image - Data Decrypted.raw
Date: 14.11.2017 15:47:50

Contacts (190)

Calls (962)
SMS Messages (129
Inbox (112)

Sent (12)

Drafts (4)
Calendar (6)
Viber (265)

Gmail (90)
Applications (220)

launcherdx5.db - favorites (22
Telegram (6135)

NTahle 0000 (4837)

NTable 0145 (1076)
NTable 0722 (114)
NTable 0549 (35)
NTable 0796 (16)
NTable 0789 (8)
NTable 0177 (7)
NTahle 0406 (6)
cached.db - messages (6)
NTahble 1486 (5)
NTable 0323 (4)
NTable 1008 (4)
NTable 1548 (4)
NTable 1368 (3)
NTable 0160 (2)

NTable 0745 (2)

Picture 7



d Data Recove

File View Help About
| Source File: D:\ Project SQLite\06passi\13\Xiaomi Redmi 44 Full Image - Data Decrypted.raw il
g::‘&;‘:z(;w) Filters. Data/Time Filter Phone Numbers Filter Text Filter | Search In All Files J | Cyrillic Filter |
SMS Messages (129) ["] pate/Time s Page 0 Fields numb. >= g
- Inbox (112) ["] Phone Mumbers
Sent (12) [ Text i . <= 0
Drafts (4) e
Other (1) -

Calendar (6) X _id |thread id address |person date |date_sent |protocol read status type reply_path_present subject body 4

Locations (0} | PEE 0920003700 2017.09.21 14:21:21 2017.09.21 14:21:15 0 i 1 [1 o 1000.00UAH Popavnennia hativkaiu v terminal samoaobsiu

Viber (265} W 15 45 4330504561156 2017.09.22 11:06:35 2017.09.22 11:06:25 0 11 1 0 [laBaMTE Ha HACTYMHOMY TVokHI B SETEEPT 3 NOTIM B pi

g':::f?;::; . 119 45 +380504561156 2017.09.22 11:06:43 2017.09.22 11:06:32 0 i |1 1 0 Lobpe??

Privatbank (0) 120 45 +330504561156 2017.09.22 11:07:17 2017.09.22 11:07:09 0 1 -1 1 0 B MEHE B YETEEPr TPM MapK aHMNifCHKoT

Applications (220) . 122 45 +380504561156 LN 1 0 A MOHEMO | B CEPENY | B HETEER??

Odnoklassniki 0920003700 1 -1 1 0 330.00UAH Perekaz z kartky ch€)T%

vk +380935547793 2017.09.09 10:57:49 2017.09.09 10:57:43 0 1 -1 1 0 A Ha 38'A3Ky! MepenssoHiTs MeHi, Byas nacka: +380955

Facebook Vodafone 2017.09.13 06:04:33 2017.09, 13 06:04:23 0 i 1 [1 o LUIAHOBHMI} KNiEHTE, CYMa PEXYHKY 38 MONEpEnHil MicaLs

Telegram (6135) VOLIA 2017.09.14 10:33:49 2017.09.14 10:33:43 0 1 1 1 o Vam narakhovano 50 bonusiv, Detalnishe na my.volis.cor

Skype (25) +380667044235 2017.09.15 16:43:38 2017.09.15 16:43:24 0 1 [ 1 |o £ Ha 38'A3Ky! TlepesBoHiT MeHi, Byas nacka: +3806671

x;:tabl& (1131722) 39 +380500520387 2017.08.16 11:53:34 2017.08.16 11:53:25 0 101 1 0 TAXI™598" Huseki Tapudi! cpoByiil HafiMpait™598"s Mobir

The result of the filter 10 +380955547793 2017.08.18 08:14:11 2017.08. 18 08:14:08 0 1 -1 1 0 H Ha 38'A3ky! MepenseoHiTe MeHi, Byas nacka: +380955

38 +3806665685288 2017.08.15 14:43:27 2017.08.15 14:43:23 0 1 -1 1 0 380HM C MofiunbHoro 797, TAKCH B YkpauHe NoHpasuTcs

. 89 3 0920003700 2017.08.18 10:15:50 2017.08.18 10:15:44 0 1 -1 1 0 MiaTeepaiTe onnaty 1.22 USD. CnispofimHuk Baricy Hikc
. S0 3 0520003700 2017.08.18 10:17:08 2017.08.18 10:17:04 0 1 1 1 0 1.22USD Internet-mahazyn WWW.ALIEXPRESS.COM 4%2
. 91 18 +380660345841 2017.08.20 07:23:10 2017.08.20 07:23:05 0 1 1 1 0 Takon JIETO Cambie YACTHIE asTo 686 GecnaTho c mofl
. 92 10 +380955547793 2017.08.21 16:24:22 2017.08.21 16:24:16 0 1 1 1 0 # Ha 38'A3Kky! MNepeassoHite mewi, Byae nacka: +380955
. 94 10 +380955547793 2017.08.27 17:04:26 2017.08.27 17:04:24 0 1 1 1 0 A Ha 38'A3Kky! MNepeassorite mew, Byae nacaka: +380955
. 95 10 +380955547793 2017.08.29 16:14:17 2017.08.29 16:14:12 0 1 1 1 0 # Ha 38'A3Kky! MNepeassoHite mew, Byae nacka: +380955
. 9% 4 +380956098730 2017.08.31 16:37:06 2017.08.31 16:37:00 0 1 |1 1 0 Tard 686 BeswowrosHo 3 Mobinbrore reflin.uafgrandta:
. 97 35 VOLIA 2017.09.0106:39:16 2017.09.0106:39:11 0 i |-l 1 0 Vam narakhovane 30 bonusiv. Detal'nishe na my.volia.cor
. 98 3 0320003700 2017.09.01 15: i |1 1 0 #Vash kod Cvv2: . Radymo zapam'yataty kod CVW2iy
. 82 10 4380255547793 2017.08.14 15: PRES § 1 0 A Ha 38'A3Ky! MepensseoHiTe MeHi, Byas nacka: +380955
. 83 10 +380955547793 2017.08.14 18:34:59 2017.08.14 18:34:55 0 1 -1 1 0 A Ha 38'A3Ky! MepenssoHiTs MeHi, Byas nacka: +380955
. 84 10 +330955547793 2017.08.15 11:29:00 2017.08.15 11:28:57 0 1 -1 1 0 A Ha 38'A3Ky! MepenssoHiTs MeHi, Byas nacka: +380955. FF
. 63 3 0920003700 2017.07.26 08:24:47 2017.07.26 08:24:41 0 1 -1 1 0 400.00UAH Zniattia hotivky v bankomati Mizhhirie, vul. Sh
. 64 3 0920003700 2017.07.26 10:38:18 2017.07.26 10:38:12 0 1 -1 1 0 185.00UAH Perekaz cherez Pryvat24 Vidpravnyk: Tereshe
. 65 3 0920003700 2017.07.26 14:41:26 2017.07.26 14:41:19 0 1 -1 1 0 200.00UAH Zniattia hotivky v bankomati Mizhhirie, vul. Sh
. 66 31 +380662640634 2017.07.28 07:00:19 2017.07.28 07:00:12 0 1 -1 1 0 Biifiop Kuesa 11 Takon MANDARIN 0962000323 050468
. 67 3 0820003700 2017.07.28 09:02:56 2017.07.28 09:02:48 0 1 -1 1 0 215.00UAH Perekaz cherez Pryvat24 Vidpravnyk: Aleksar
. 69 32 +380504691797 1 -1 1 0 59903
. 70 33 ZDOR APTEKA 2017.07.29 13:42:10 2017.07.29 13:41:58 0 1 -1 1 0 1740.00 rpH. Peseps: 19253 yn. M.boiuyka (Kiuksuase)
. 713 0920003700 2017.07.30 16:04:51 2017.07.30 16:04:42 0 101 1 0 390.00UAH Perekaz na kartku cherez Pryvat24. Oderzhuy
. 72 4 Vodafone 2017.08.01 16:31:06 2017.08.01 16:30:57 0 1 -1 1 0 Vash rakhunok popovneno na 8 hrn. Diakuiemo!
| ERE Vodafone 2017.08.05 07:32:15 2017.08.05 07:32:05 0 E e LLIZHOBHMIA KJiEHTE, CYMa PAXYHKY 33 NONEPERHIA MICLE
. 75 34 +380999313614 2017.08.07 17:57:25 2017.08.07 17:57:22 0 1 1 1 0 # Ha 38's3Ky! MepeassoHiTe veHi, Byas nacka: +380999.
. 7w 3 0520003700 2017.08.08 06:22:37 2017.08.08 06: 1 1 1 0 640.00UAH Popovnennia hotivkoiu v terminali samoobsluh
. 77 3 0920003700 2017.08.08 10:12:21 2017.08.08 10: 1 1 1 0 650.00UAH Zniattia hotivky v bankomati Kyiv, prosp. Nau
. 78 35 VOLIA 2017.08.09 10:23:38 2017.08.09 10:23:34 0 1 1 1 0 Vam narakhovane 50 bonusiv. Detal'nishe na my.volia.cor
. 48 3 0920003700 2017.07.08 17:04:47 2017.07.08 17:04:40 0 1 1 1 0 BankID : 51-56-43
. 51 26 +380679735606 2017.07.1205:30:27 2017.07.1205:30:22 0 i |-l 1 0 Ok
Bl = LEERLRER MAT AT 42 1542044 WMAT AT 42454207 0 1 1A Minraennine annary EN2 I MO Crisnofire e o
WO 4 13112 b = v X (o) = 2

Picture 8

5. The menu item 'View' -> Detailed/Shortend' for some data types (messages,
contacts) removes from a display secondary columns (picture 8-9).



File View Help About

Source File: D:\_Project SQLite\OBpasei\13\Xiaomi Redmi 4A Full Image - Data Decrypted.raw i
Contacts (190) . - i
Calls (962) Filters Data/Time Filter Phane Numbers Filter Text Filter Search In All Files Cyrillc Filter
¥ SMS Messages (129) Date/Time < Page 0 Fields numb.>= [0
Inbox (112) Phone Numbers
Sent (12) Text < “ » a<=|o
Drafts (4)
Other (1)
calendar (6) X _|address date body i
Locations (0) . 0920003700 2017.09.2109:34:19 150.00UAH Popovnennia v terminali samoobsluhovuvannia: vul. Malyshka, bud. 27 469 12:33 Bal. 219.96UAH https:/fgoo.al/EZUEKy
Viber (265) [ 0520003700 2017.08.21 14:21:21 1000.00UAH Popovnennia hotivkoiu v terminali samoobsiuhovuvannia. Platnyk: Onotska V. V. 4%69 17:20 Bal. 1219.96UAH https: /fgoo.gl/EZuEKy
zvr:::lsg':)'; [l +350504561156 2017.02.22 11:05:35 AasaliTe Ha HaCTyrHOMY TIDKHi B YETEEPr @ NOTiM S pilueto
Privatbank (0) . +380504561156 2017.09.22 11:06:43 Lobpe??
Applications (220) [l +380504561156 2017.09.22 11:07: 17 B MeHe B HETSEPr TPH Naph SHrAifCsKol
odnokdassniki [l +380504561156 2017.09.22 11:08: 57 A mosemo i B cepeay i B ueTEep??
vk Ml 0520003700 2017.09.08 16:40: 14 380.00UAH Perekaz z kartiy ch@T%
Facebook [l +380955547793 2017.09.09 10:57:49 5 va 36'm3y! MepensBOHITL MeH, Gyas nacka: +380955547793
Telegram (6135) Ml vodafone 2017.02.13 06:04: 29 LiaHoBHMW KiiieHTe, CyMa paxyHIcy 3a nonepenrin Mcal - 6,50 rpn, Mepesipia noTosHore Banarcy: *110%10# MonosHaTy 3apas: vodafone.ua/pay
Skype (25) Il voua 2017.09. 14 10:33:43 Vam narakhovano 50 bonusiv. Detalnishe na my.volia.com
gtol?:tzbles (1131722) +380867044235 2017.09.15 16:43:38 A Ha se'sacy! MNepeassonite mewi, Gyas nacka: +380667044235
The result of the filter . +380500520387 2017.08.16 11:53:34 TAXI"538" HusbKi Taprdm!pobyii! Habupaii™598"s mofinsHaro!

. +380955547793 2017.08.18 08:14:11 A Ha 36'Asky! MepenssoHite Mewi, Byas nacka: +380955547793

. +380666685288 2017.08.15 14:43:27 3g0tM ¢ MoBunbHoro 797, TAKCH B YKpanHe NoHpasHTCA BCem

. 0920003700 2017,08.18 10:15:50 NiaTsepaits onnaty 1,22 USD. CrispofiTHuk BanKy HiKonM HE 3aMMTYE naponi, Hikomy He nepenasaiTe Lel napons: 18309664

. 0920003700 2017.08.18 10:17:08 1.22USD Internet-mahazyn WWW.ALIEXPRESS.COM 424 13:16 Bal. 18.63UAH Kurs 25.7049 UAH/USD https://pb.ua/s/p24/2

. +380660345841 2017.08.20 07:23:10 Taxok JIETO Cambie YACTHIE asTo 586 Gecnnatho ¢ mofunsHore 100% nogaqa

. +380955547793 2017.08.21 16:24:22 f Ha 38'AsKy! MepenssoHiTe Mewi, Byas nacka: +380355547793

. +380955547793 2017.08.27 17:04:26 # Ha 36'A3Ky! MepenssoHits mewi, Gyab nacka: +380955547793

. +380955547793 2017.08.29 16:14:17 A na 36'A3ky! MepenssoHite mewi, Byas nacka: +380955547793

. +380356098730 2017.08.31 16:37:06 Taxd 686 BeskowTosHo 3 MobinsHoro ref.in.ua/fgrandtaxi

2017.09.0106:39: 16 Vam narakhovano 30 bonusiv. Detal'nishe na my. volia.com

. 0920003700 2017.09.01 15:28:44 #Vash kod CWV2: . Radymo zapam ‘yataty kod CVV2i vydalyty SMS. Vdalyh pokupok! pb.ua/itcard

. +380955547793 2017.08.14 15:38:50 f Ha 36'Asky! MepenssoHite Mewi, Byas nacka: +380955547793

. +380955547793 2017.08.14 18:34:59 # Ha 36'A3Ky! MNepenssoHite mewi, Byas nacka: +380955547793

. +380955547793 2017.08.15 11:29:00 A Ha 38'A3Ky! MepensBoHiTe MeHi, Gyas nacka: +380955547793

[l 0520003700 2017.07.26 08:24:47 400.00UAH Zniattia hotivky v bankomati Mizhhirie, vul. Shevchenka, bud. 97 4¥69 11:23 Komisia 4,00UAH Bal. 21.36UAH https:/jpb.ua/s/p24/2
M 0520003700 2017.07.26 10:38:18 185.00UAH Perekaz cherez Pryvat24 Vidpravnyk: Tereshchenko Natalia Volodymyrivna 4°69 13:36 Bal. 206.36UAH https://pb.ua/s/p24/2

[l 0520003700 2017.07.26 14:41:26 200.00UAH Zriattia hotivky v bankomati Mizhhirie, vul. Shevchenka, bud. 97 4%63 17:40 Komisiia 2,00UAH Bal. 4.36UAH https: //pb.ua/s/p24/2
. +380662640634 2017.07.28 07:00: 19 Buifiop Knesa *1 Takor MANDARIN 0962000323 05046856101 0632000323

Il 0520003700 2017.07.28 09:02:56 215.00UAH Perekaz cherez Pryvat24 Vidpravnyk: Aleksandrova Mariia Serhivna 4769 12:01Bal. 219.35UAH hitps://pb.ua/s/p24/2

. +380504691797 2017.07.29 13:33:43 59903

ZDOR APTEKA  2017.07.29 13:42:10 1740.00 rpn. Peseps: 19253 yn, M. Boiuyia (Kikenase) 1/2, KpyrnocyTouro

. 0920003700 2017.07.30 16:04:51 390.00UAH Perekaz na kartiu cherez Pryvat24. Oderzhuvach: Zakharchenko Alona Viktorivna 4¥69 19:03 Bal. 29.36UAH https: /fpb.ua/sfp24/2
W vodafone 2017.08.01 16:31:06 Vash rakhunok popovneno na 8 hrn, Diakuiemo!

M vodafone 2017.08.05 07:32: 15 LIGHOBHMIA KIIEHTE, CyMa PaxyHIcy 3a Nonepenri Mcsl - 18,6 1rpH. Mepesipka noTedrHoro Ganarcy: *110%10%

. +380999313614 2017.08.07 17:57:25 A Ha 38'A3Ky! MepenssoHiTb MeHi, yas nacka: +380999313614

M 0520003700 2017.08.08 06:22:37 640.00UAH Popovnennia hotivkoiu v terminali samoobsluhovuvanmia, Platnyk: tel. (+38097)*%98 4%69 09:19 Bal. 669.36UAH https://pb.ua/s/p24/2
Il 0520003700 2017.08.08 10:12:21 650.00UAH Zniattia hotivky v bankemati Kyiv, prosp. Nauky, b. 9 4%69 13:11 Komisia 5. 50UAH Bal. 12.85UAH https://pb.ua/s/p24/2

. VOLIA 2017.08.09 10:23:38 Vam narakhovano 50 bonusiv. Detalnishe na my. volia.com

Ml 0520003700 2017.07.08 17:04:47 BankiD : 51-56-43
Bl | 20023079ESAS IN1T AT 17 AGANTT Ao
W44 13112 (b0 F = & v X ) K D < = >

Picture 9

6. The menu item 'File' -> "Exit' is used for program exit.

It is created and used temporary folder 'TEMP\{E45B4D14-3645-423A-A24A-
6740E4568E55 NADR\' during the program session which will be cleaned after the
program closing.



6. Program’s messages description.
Warning messages:

1. 'Folder ... RESULT"+" already exists! Erase this folder and continue?'

Information ot

o Folder 'O _Project SCLite\ OBpazei 13 Xiaomi Redmi 44
Full Image - Data Decrypted.raw_RESULT' already exists!
Erase this folder and continue?

In this case, there are two variants:

- to select "Yes' in order to clean the folder and continuing the recovery process

- to select 'No' in order to stop the recovery process.

Error messages:

1. "The program is already run — exe-file of ADR512wl.exe or
ADRb512Trialwl.exe is already run.

ADRS12. exe >

The program is already running

OK

For solution, it is necessary to finish the exe-file run earlier.

2. In case of an unforeseen error we recommend to address to Support Service of
the Android Data Recovery program with the description of an error and contents of
the text file 'glog.log’ which is created and re-recorded in case of each program

fulfillment.



7. Links

[1] https://www.sqlite.org/fileformat.html.

Return to Content.
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